
Mac OS X Server
Deploying Mac OS X Server 
for High Performance Computing
For Version 10.4 or Later



K

 

Apple Computer, Inc.
© 2005 Apple Computer, Inc. All rights reserved.

The owner or authorized user of a valid copy of 
Mac OS X Server software may reproduce this 
publication for the purpose of learning to use such 
software. No part of this publication may be reproduced 
or transmitted for commercial purposes, such as selling 
copies of this publication or for providing paid-for 
support services.

Every effort has been made to ensure that the 
information in this manual is accurate. Apple Computer, 
Inc., is not responsible for printing or clerical errors.

Apple
1 Infinite Loop
Cupertino CA 95014-2084
www.apple.com

The Apple logo is a trademark of Apple Computer, Inc., 
registered in the U.S. and other countries. Use of the 
“keyboard” Apple logo (Option-Shift-K) for commercial 
purposes without the prior written consent of Apple 
may constitute trademark infringement and unfair 
competition in violation of federal and state laws.

Apple, the Apple logo, AppleShare, AppleTalk, Mac, 
Macintosh, QuickTime, Xgrid, and Xserve are trademarks 
of Apple Computer, Inc., registered in the U.S. and other 
countries. Finder is a trademark of Apple Computer, Inc. 

Adobe and PostScript are trademarks of Adobe Systems 
Incorporated.

Java and all Java-based trademarks and logos are 
trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.

UNIX is a registered trademark in the United States and 
other countries, licensed exclusively through 
X/Open Company, Ltd.

of third-party products is for informational purposes 
only and constitutes neither an endorsement nor a 
recommendation. Apple assumes no responsibility with 
regard to the performance or use of these products.

019-0420/08-22-05



 

    

 

 

 

3

 

1

 

Contents

 

Preface 5 About This Guide
5

 

What’s New in Version 10.4

 

5

 

What’s in This Guide

 

6

 

The Mac OS X Server Suite

 

7

 

Getting Documentation Updates

 

8

 

Getting Additional Information

 

Chapter 1 9 Introduction
9

 

What’s High Performance Computing?

 

9

 

Apple in High Performance Computing

 

10

 

Mac OS X Server

 

10

 

Xserve G5 and Xserve G5 Cluster Node

 

11

 

Xserve G5 Clusters

 

11

 

Xserve G5 64-Bit Architecture

 

13

 

Supported Computational Domain

 

Chapter 2 15 Expectations and Requirements
15

 

Expectations

 

15

 

Expertise

 

15

 

Xserve G5 Configuration

 

16

 

Requirements

 

16

 

Physical Infrastructure Requirements

 

19

 

Static IP Address and Hostname Requirements

 

20

 

Cluster Management Requirements

 

20

 

Software Requirements

 

Chapter 3 23 Preparing the Cluster for Configuration
23

 

Preparing the Cluster Nodes For Software Configuration

 

25

 

Setting Up the Management Computer

 

26

 

Cluster Setup Overview

 

Chapter 4 27 Setting Up the Head Node
27

 

Setting Up the Server Software on the Head Node

 

32

 

Configuring the TCP/IP Settings for Ethernet Port 2



 

4

 

Contents

 

33

 

Connecting the Head Node and the Management Computer to the Public Network

 

33

 

Running Software Update on the Head Node

 

34

 

Configuring the TCP/IP Settings for Ethernet Port 1

 

35

 

Configuring Firewall Settings on the Head Node

 

36

 

Configuring NAT Settings on the Head Node

 

36

 

Configuring the DHCP Service

 

39

 

Configuring the DNS Service

 

41

 

Configuring the VPN Service

 

43

 

Configuring the Head Node As an Open Directory Master

 

45

 

Configuring the Xgrid Service

 

Chapter 5 47 Setting Up Compute Nodes
47

 

Creating an LDAP Record For Setting Up Compute Nodes

 

50

 

Verifying LDAP Record Creation

 

51

 

Setting Up the Compute Nodes

 

51

 

Creating a VPN Connection on the Management Computer

 

52

 

Configuring Xgrid Agent Settings

 

Chapter 6 55 Testing Your Cluster
55

 

Checking Your Cluster Using Xgrid Admin

 

57

 

Running a Sample Xgrid Task

 

Chapter 7 61 Solving Problems
61

 

Can’t See the Head Node in Server Assistant

 

62

 

I can’t reach the head node via the public network using Apple Remote Desktop

 

63

 

System icon in Apple Remote Desktop is black (not blue), and I can’t verify the 
administrator password

 

63

 

Cluster nodes don’t automatically apply their settings and reboot

 

63

 

Cluster trips the breaker of the power distribution unit or wall outlet

 

64

 

Something went wrong and I need to start over

 

Appendix 65 Cluster Setup Checklist

Glossary 67

Index 75



 

    

 

 

 

5

 

Pr
ef

ac
e

 

About This Guide

 

This guide describes how to set up and configure a cluster of 
Xserve G5 computers for high performance computing.

 

This guide shows you how to leverage the power of Mac OS X Server version 10.4 
running on dual-processor Xserve G5 computers to provide high performance 
computing (HPC) solutions to your organization.

 

What’s New in Version 10.4

 

Mac OS X Server version 10.4 offers major enhancements that support HPC:
Â

 

Xgrid—distributed resource manager which simplifies deployment and management 
of computational clusters.

Â

 

GCC 4.0—an auto-vectorizing compiler that enables out-of-the-box open source or 
in-house code to take advantage of vector capabilities of a processor without tying 
the application to a specific processor architecture.

Â

 

Optimized math libraries—math libraries, including BLAS, LAPACK, and an excellent 
FFT implementation, have been optimized to improve performance.

Â

 

Development tools—Xcode 2.0 supports the development and compiling of 64-bit 
applications on any Mac running Mac OS X Server v10.4.

 

What’s in This Guide

 

This guide includes the following chapters:
Â

 

Chapter 1, “Introduction,” explains what high performance computing is and how 
Apple supports it.

Â

 

Chapter 2, “Expectations and Requirements,” describes the assumptions and 
requirements for setting up your Apple cluster.

Â

 

Chapter 3, “Preparing the Cluster for Configuration,” describes how to prepare the 
physical infrastructure for the cluster.

Â

 

Chapter 4, “Setting Up the Head Node,” describes how to configure the head node’s 
server software, network settings, and services.
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Â

 

Chapter 5, “Setting Up Compute Nodes,” describes how to automatically configure 
the cluster’s compute nodes.

Â

 

Chapter 6, “Testing Your Cluster,” describes how to test your cluster using Xgrid 
Admin and by running sample Xgrid tasks.

Â

 

Chapter 7, “Solving Problems,” tells you how to solve common problems that you 
might encounter when setting up or using your cluster.

Â

 

Appendix, “Cluster Setup Checklist” has a checklist that you can use to make sure 
that you perform all the steps required for setting up your cluster.

Â

 

The glossary provides brief definitions of terms used in this guide. 

 

Note:  

 

Because Apple frequently releases new software versions and updates, images 
shown in this book may be different from what you see on your screen.

 

The Mac OS X Server Suite

 

The Mac OS X Server documentation includes a suite of guides that explain the 
Mac OS X Server services and provide instructions for configuring, managing, and 
troubleshooting the services. All of the guides are available in PDF format from:

www.apple.com/server/documentation/

 

This guide ... tells you how to:

 

Mac OS X Server Getting Started 
for Version 10.4 or Later

 

Install Mac OS X Server and set it up for the first time.

 

Mac OS X Server Upgrading and 
Migrating to Version 10.4 or Later

 

Use data and service settings that are currently being used on 
earlier versions of the server.

 

Mac OS X Server User 
Management for Version 10.4 or 
Later

 

Create and manage users, groups, and computer lists. Set up 
managed preferences for Mac OS X clients.

 

Mac OS X Server File Services 
Administration for Version 10.4 or 
Later

 

Share selected server volumes or folders among server clients 
using these protocols:  AFP, NFS, FTP, and SMB/CIFS.

 

Mac OS X Server Print Service 
Administration for Version 10.4 or 
Later

 

Host shared printers and manage their associated queues and print 
jobs.

 

Mac OS X Server System Image 
and Software Update 
Administration for Version 10.4 or 
Later

 

Use NetBoot and Network Install to create disk images from which 
Macintosh computers can start up over the network. Set up a 
software update server for updating client computers over the 
network.

 

Mac OS X Server Mail Service 
Administration for Version 10.4 or 
Later

 

Set up, configure, and administer mail services on the server.

 

Mac OS X Server Web 
Technologies Administration for 
Version 10.4 or Later

 

Set up and manage a web server, including WebDAV, WebMail, and 
web modules.

http://www.apple.com/server/documentation/
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Getting Documentation Updates

 

Periodically, Apple posts new onscreen help topics, revised guides, and additional 
solution papers. The new help topics include updates to the latest guides.

 

Mac OS X Server Network Services 
Administration for Version 10.4 or 
Later

 

Set up, configure, and administer DHCP, DNS, VPN, NTP, IP firewall, 
and NAT services on the server.

 

Mac OS X Server Open Directory 
Administration for Version 10.4 or 
Later

 

Manage directory and authentication services.

 

Mac OS X Server QuickTime 
Streaming Server Administration 
for Version 10.4 or Later

 

Set up and manage QuickTime streaming services.

 

Mac OS X Server Windows 
Services Administration for 
Version 10.4 or Later

 

Set up and manage services including PDC, BDC, file, and print for 
Windows computer users.

 

Mac OS X Server Migrating from 
Windows NT for Version 10.4 or 
Later

 

Move accounts, shared folders, and services from Windows NT 
servers to Mac OS X Server.

 

Mac OS X Server Java Application 
Server Administration For Version 
10.4 or Later

 

Configure and administer a JBoss application server on 
Mac OS X Server.

 

Mac OS X Server Command-Line 
Administration for Version 10.4 or 
Later

 

Use commands and configuration files to perform server 
administration tasks in a UNIX command shell. 

 

Mac OS X Server Collaboration 
Services Administration for 
Version 10.4 or Later

 

Set up and manage weblog, chat, and other services that facilitate 
interactions among users.

 

Mac OS X Server High Availability 
Administration for Version 10.4 or 
Later

 

Manage IP failover, link aggregation, load balancing, and other 
hardware and software configurations to ensure high availability of 
Mac OS X Server services.

 

Mac OS X Server Xgrid 
Administration for Version 10.4 or 
Later

 

Manage computational Xserve clusters using the Xgrid application.

 

Mac OS X Server 
Glossary: Includes Terminology for 
Mac OS X Server,  Xserve, Xserve 
RAID, and Xsan

 

Interpret terms used for server and storage products.

 

Deploying Mac OS X Server for 
High Performance Computing

 

How to configure Mac OS X Server for computational clustering.

 

Apple Remote Desktop 
Administrator’s Guide

 

Remotely distribute software, configure systems, offer real-time 
online help, and create detailed hardware and software reports for 
Mac systems, all from your Mac.

 

This guide ... tells you how to:



 

8 Preface

 

    About This Guide 

 

 

Â

 

To view new onscreen help topics, make sure your server or administrator computer 
is connected to the Internet and click the Late-Breaking News link on the main 
Mac OS X Server help page.

Â

 

To download the latest guides and solution papers in PDF format, visit the Mac OS X 
Server documentation webpage:  www.apple.com/server/documentation.

 

Getting Additional Information

 

For more information, consult these resources:

 

Read Me documents

 

—important updates and special information. Look for them on the 
server discs.

 

Mac OS X Server website

 

—gateway to extensive product and technology information.
www.apple.com/macosx/server/

 

High-Performance Computing website

 

—access to information and resources about 
cluster computing.
www.apple.com/xserve/cluster/resources.html

 

Compute Clustering Resources website

 

—access to information and resources about HPC.
www.apple.com/science/software/highperformancecomputing.html

 

High Performance Computing on Mac OS X

 

—open source tools and compilers for 
creating high performance solutions on the Mac.
hpc.sourceforge.net/

 

Apple Remote Desktop 2 website—

 

access to information and resources about Apple 
Remote Desktop 2.
www.apple.com/remotedesktop/

 

AppleCare Service & Support

 

—access to hundreds of articles from Apple’s support 
organization.
www.apple.com/support/

 

Apple customer training

 

—instructor-led and self-paced courses for honing your server 
administration skills.
train.apple.com/

 

Apple discussion groups

 

—a way to share questions, knowledge, and advice with other 
administrators.
discussions.info.apple.com/

 

Apple mailing list directory

 

—subscribe to mailing lists so you can communicate with 
other administrators using email.
discussions.info.apple.com/
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1 Introduction

High performance computing lets you speed up the 
processing of complex computations.

This chapter provides a brief description of high performance computing (HPC) and 
how it’s supported by Apple technology. 

What’s High Performance Computing?
High performance computing (HPC) is a broad concept that refers to the use of high-
end computer systems to solve computationally intensive problems. HPC includes large 
supercomputers, symmetric multiprocessing (SMP) systems, cluster computers, and 
other hardware and software architectures. In recent years, developers have made it 
feasible for standard, off-the-shelf computer systems to achieve supercomputer-scale 
performance by clustering them together in efficient ways.

Apple in High Performance Computing
Apple’s hardware and software facilitate high performance computing in unique and 
meaningful ways. While many hardware and software architectures can be used for 
cluster computing, Mac OS X Server v10.4 and Xserve G5 have specific features that 
enhance the performance and manageability of cluster installations.

The integration of Xserve G5 with Mac OS X Server provides unparalleled ease of use, 
performance, and manageability. Because Apple makes both the hardware and the 
software, the benefits of tight integration are immediately evident in the quality of the 
user experience with a Macintosh-based cluster.



10 Chapter 1    Introduction 

 

Mac OS X Server
Mac OS X Server v10.4, Apple’s UNIX-based server operating system, provides a full 
64-bit environment for high-end computing while simultaneously running 32-bit 
applications without performance degradation. The Mach kernel provides preemptive 
multitasking for outstanding performance, protected system memory for rock-solid 
stability, and modern SMP locking for efficient use of dual-processor systems. 
Mac OS X Server also includes highly optimized math libraries that allow software 
developers to take maximal advantage of the G5 processor without the use of difficult 
programming techniques or expensive development tools. Mac OS X Server also 
includes Xgrid, an integrated distributed resource manager for both grids and clusters.

Xserve G5 and Xserve G5 Cluster Node
To facilitate high performance computing, Apple provides the dual-processor Xserve 
G5 system and the Xserve G5 cluster node. Both systems are designed for 
straightforward manageability and maintenance.

Apple’s dual-processor Xserve G5 provides two 64-bit processors, large amounts of 
error-correcting RAM, and industry-leading storage densities in a standard 1U server. 
The G5 processor is energy-efficient; it draws substantially less power than competitive 
servers with lesser computational performance. 

The Xserve G5 cluster node is a lighter version of the dual-processor Xserve G5 
designed specifically for cluster computing. 

An Xserve G5 cluster node provides the same high performance architecture as the 
standard Xserve G5, but with unneeded components removed to reduce power 
consumption, heat dissipation, and acquisition cost for large cluster installations. 

The Xserve G5 cluster node differs as follows:
Â It has only one hard drive bay, unlike the Xserve G5, which has three hard drive bays.
Â It has no optical drive.
Â Its design allows for additional airflow through the front panel, reducing blower 

speeds.

Note:  In this guide, references to the Xserve G5 imply the dual-processor version.
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Xserve G5 Clusters
Using a combination of dual-processor Xserve G5 system and the Xserve G5 cluster 
node systems, you can build clusters that aggregate the power of these systems to 
provide high performance computing solutions at comparatively low cost.

An Xserve G5 cluster consists three or more nodes:  a head node and two or more 
compute nodes. Typically, the head node is an Xserve G5 system and the compute 
nodes are Xserve G5 cluster node systems. 

Xserve G5 64-Bit Architecture
The 64-bit architecture of Xserve G5 systems is ideal for high performance computing 
applications. It provides 64-bit math precision, higher data throughput, and very large 
memory space.

Memory Space
The 64-bit architecture provides 4 billion times the memory space available in a 32-bit 
architecture, which puts the theoretical address space available to Mac OS X Server 
v10.4 applications at 16 exabytes. While current Xserve G5 systems support a maximum 
of 8 GB of memory, future systems will be able to take advantage of advances in 
memory capacity.

Application Development
Mac OS X Server v10.4 comes with Xcode 2.0, which lets you develop, compile, and 
build 64-bit high performance applications for G5 systems. Although high performance 
applications run only on G5 systems, you can use Xcode 2.0 to develop your 
applications on PowerPC G3, G4, and G5 systems. You can also use Xcode 2.0 to 
remotely debug your applications. 

Xserve G5 cluster

Head node

Compute nodes
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Libraries
Mac OS X Server v10.4 provides highly optimized libraries for developing high 
performance applications. In addition to standard libraries like libSystem, numerical 
libraries like BLAS, LAPACK, and others provide industry-standard routines that have 
been hand-tuned for the G5 processor. Developers can make efficient use of the 
system architecture without writing machine code or vector code. 

Easy Porting of UNIX Applications
Mac OS X Server v10.4 uses the same programming model for representing 64-bit data 
(LP64) as other UNIX-based systems (for example, Linux, Solaris, and HP-UX). As a result, 
you can easily port your high performance applications from other platforms to 
Mac OS X Server.

Library Description

libSystem A collection of core system libraries

libMathCommon Common math functions library

vDSP Provides mathematical functions for applications that operate on 
real and complex data types. 

BLAS Basic Linear Algebra Subprograms, a standard set of building 
blocks for vector and matrix operations

LAPACK Linear Algebra Package, a standard library for solving simultaneous 
linear equations

vForce Highly-optimized single- and double-precision mathematical 
intrinsic functions

vBasicOps Collection of basic operations that complement the vector 
processor’s basic operations up to 128 bits.

vBigNum Optimized arithmetic operations for 256-, 512-, and 1024-bit 
operands
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Supported Computational Domain
You can use Xserve G5 clusters to perform most types of loosely coupled or 
embarrassingly parallel computations. Embarrassingly parallel computations consist of 
somewhat independent computational tasks that can be run in parallel on many 
different processors to achieve faster results.

Here are examples of loosely coupled computations that you can accelerate using the 
setup described in this guide:
Â Image rendering. Different rendering tasks, such as ray tracing, reflection mapping, 

and radiosity, can be accelerated by parallel processing.
Â Bioinformatics. The throughput of bioinformatics applications like BLAST and 

HMMER can be greatly enhanced by running them on a cluster. 

Note:  The Apple Workgroup Cluster for Bioinformatics is a preconfigured turnkey 
solution from Apple for quickly deploying and managing a high performance cluster 
that runs bioinformatics applications. Visit www.apple.com/xserve/cluster/
workgroupcluster/ for more information.

Â Cryptography. Brute-force key search is a classic example of a cryptography 
application that can be greatly accelerated when run on a computer cluster.

Â Data mining. High performance computing is essential in data mining, because of 
the huge amount of data that is analyzed and because of the many computations 
that are performed during the analysis and result presentation processes. 

Note:  This guide assumes that the cluster nodes will communicate over Gigabit 
Ethernet. Although the network latency of Gigabit Ethernet is low enough for most 
loosely coupled computations, some computations require much lower latency and 
hence may not be suited for the type of cluster you are building.

http://www.apple.com/xserve/cluster/workgroupcluster/
http://www.apple.com/xserve/cluster/workgroupcluster/
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2 Expectations and Requirements

Before setting up your Xserve G5 cluster, read the 
expectations and requirements discussed in this chapter 
and familiarize yourself with the setup process.

To ensure successful setup of your Xserve G5 cluster, read this chapter to familiarize 
yourself with the expectations and requirements that you must fulfill before starting 
the setup procedure. Then read the last section, which provides an overview of the 
cluster setup process.

Expectations
This guide assumes you have the expertise needed to set up and manage the cluster, 
perform the initial configuration of the cluster nodes, and execute the types of 
computations you can perform on the cluster.

Expertise
To set up and deploy Xserve G5 clusters, you should have a good understanding of 
how Mac OS X Server works and a fundamental understanding of UNIX and Xgrid.

Xserve G5 Configuration
This guide assumes that you’ll be using brand new, out-of-the-box Xserve G5 and 
Xserve G5 cluster node systems running Mac OS X Server v10.4. If not, you’ll have to 
install a clean version of Mac OS X Server v10.4 on these systems.
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Requirements
Take time to define the requirements needed to ensure a successful cluster setup.

Physical Infrastructure Requirements
To set up an Apple cluster, you should have the necessary hardware infrastructure in 
place. This includes, but is not limited to:
Â Racks
Â Electrical power
Â Cooling system
Â Network access points and switches

This section describes the most important hardware infrastructure requirements. You 
should consult with your system administrator about other requirements. For example, 
you might need one or more uninterruptible power supplies (UPS) to provide backup 
power to key cluster components. Another requirement might be a security system to 
protect the cluster from unauthorized access to sensitive information.

Power Requirements
There are two power consumption figures associated with your servers that you should 
consider when setting up the physical infrastructure for your cluster. 
Â Rated power consumption. This figure represents the maximum possible power 

consumption of a given system’s power supply.
Â Typical power consumption. This figure represents the typical power consumption 

of a server under normal operating conditions.

Note:  This section focuses only on the rated power consumption figure, because it 
guarantees that your circuit won’t be overloaded at any time—unlike the typical power 
consumption figure, which doesn’t protect your circuit from abnormal surges in power 
consumption.

To calculate the current requirements (measured in amperes) for your cluster using the 
rated power consumption figure, use the following formula:

Rated current (amperes) = (max. watts used by head node/voltage) + 
number of compute nodes * (max. watts used by compute node/voltage)

To obtain the power consumption figures for the cluster nodes, see article 86694, 
“Xserve G5: Power consumption and thermal output (BTU) information,” on the 
AppleCare Service & Support website at:

www.info.apple.com/kbnum/n86694

www.info.apple.com/kbnum/n86694
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For example, if the voltage is 120 and you have a cluster of 4 nodes—1 maximally 
configured Xserve G5 computer and 3 maximally configured Xserve G5 cluster nodes— 
the power requirements for your cluster will be:

Rated current = (290 W/120 V) + 3 * (252 W/120 V) = 2.42 A + 3 * 2.1 A = 8.72 A

Although the rated current load covers the cluster nodes, you also have to consider the 
power consumption of the other devices connected to your circuit.

Note:  If your cluster consists of more than 64 computers, speak with your Apple 
systems engineer to determine the appropriate power infrastructure.

Cooling Requirements
It’s very important to keep your Xserve computers running within normal operating 
temperatures (visit www.apple.com/xserve/specs.html for more information). If your 
servers overheat, they will shut themselves down, and any work being done will be 
lost. You can also damage or shorten the life span of your servers by running them at 
high temperatures. To prevent damage, carefully evaluate your cluster’s needs.

To determine the minimum cooling requirements for your cluster, use the following 
formula to add up the maximum thermal output of the cluster nodes: 

Cluster cooling requirements = max. head node thermal output + 
number of compute nodes * (max. compute node thermal output)

To obtain the thermal output figures for the cluster nodes, see article 86694, 
“Xserve G5: Power consumption and thermal output (BTU) information,” on the 
AppleCare Service & Support website at:

www.info.apple.com/kbnum/n86694

For example, if your cluster consists of a maximally configured dual processor Xserve 
G5 computer and 11 minimally configured Xserve G5 cluster node computers, the 
minimum cooling requirements will be:

Cluster cooling requirements = 990 BTU/h + (11 * 819 BTU/h) = 9,999 BTU/h

Warning:  The formulas presented in this section are intended to help you estimate 
your power requirements. These estimates may not be high enough, depending on 
your configuration. For example, if your cluster uses one or more Xserve RAID 
systems, or other third-party hardware, you’ll need to factor in their power 
consumption requirements. Consult with the appropriate people in your organization 
to determine the exact power requirements for your cluster.

http://www.apple.com/xserve/specs.html
www.info.apple.com/kbnum/n86694
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To offset the thermal output of your cluster in this example, you might use a large 
10,000 BTU/h air conditioning unit, but it might not be enough. You should also 
consider the thermal output of other devices, such as the management computer, 
Xserve RAID systems, monitors, and any other heat-generating device used in the same 
room. You should also consider external factors impacting temperature, such as 
weather, when calculating cooling needs. For example, you should take into account 
the additional cooling needs during hot summer days.

As always, consult with your system administrator to determine the appropriate level of 
cooling that your cluster and its associated hardware require for safe and smooth 
operation.

Weight Requirements
An Xserve G5 system with three Apple Drive Modules weighs 37 pounds (16.6 kg). An 
Xserve G5 cluster node weighs 33 pounds (15.1 kg). To determine your cluster weight 
requirements, add up the weight of the servers in the cluster. To obtain the weight 
information, visit www.apple.com/xserve/specs.html.

You’ll also have to factor in the weight of the rack if you’re bringing in a dedicated rack, 
and the weight of other devices used by the cluster.

After determining the weight requirements, consult with your facilities personnel to 
ensure that the room in which the cluster will be installed meets the weight 
requirements.

Note:  If you’re mounting the cluster nodes in a rack with casters, set up the rack in the 
location where you’ll keep the cluster and then mount the systems. A heavy rack is 
difficult to move, particularly across carpet. In addition, the vibrations caused by 
moving your cluster long distances while racked might damage your hardware.

Space Requirements
You should have enough space to house the cluster and allow easy access to it to 
perform routine maintenance tasks. Also, you should find a place for the cluster where 
it doesn’t affect and isn’t affected by other hardware in your server room.

Consider the following when choosing a location for your cluster:
Â Don’t place the cluster next to an air vent, air intake, or heat source.
Â Don’t place the cluster directly under a sprinkler head.
Â Don’t obstruct doors (especially emergency exit doors) with your cluster.
Â Leave enough room in front of, beside, and especially behind your cluster.
Â Ensure that air can flow around the cluster. The room might be very well cooled, but 

if air can’t easily flow around the cluster, your computers can still overheat.

http://www.apple.com/xserve/specs.html
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If you’re housing your cluster in a machine room, make sure you have at least 18 inches 
of clearance on the front and back of your systems. If you’re housing it in an office or 
other unmanaged space, make sure your cluster has at least 18 inches of clearance on 
all sides of the rack. You should have enough space to open the rack’s door, slide out 
systems, and perform other routine maintenance tasks.

Network Requirements
Your cluster requires access to two networks:
Â Private network. This is a high performance Gigabit Ethernet network. You’ll need to 

have at least a 1-gigabit switch.
Â Public network. This network connects the cluster’s head node to the client 

computers that will be submitting jobs to your cluster. 

Static IP Address and Hostname Requirements
Your cluster requires a single static IP address and a matching fully qualified and 
reverse resolvable hostname for the head node.

Using a static IP address, as opposed to a dynamic one, allows you to maintain a 
consistent address that clients can always use.

Note:  You should initiate the process of requesting an IP address and a hostname as 
early as possible before setting up the cluster, to allow for the lead time typically 
required.

18”

18” 18”

18”

Private Network

Gigabit switch

Public Network
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Cluster Management Requirements
To manage the cluster, you’ll need a computer running Mac OS X v10.4 and the latest 
version of Server Tools. This computer is referred to as the management computer 
throughout this guide.

Software Requirements
You need a site-licensed copy of Mac OS X Server v10.4, one or more copies of Apple 
Remote Desktop 2.2 or later, and the latest version of Server Tools.

Site-Licensed Serial Number
You need to obtain a site-licensed serial number to run multiple copies of Mac OS X 
Server. Contact your local Apple sales person if you haven’t already obtained such a 
serial number.

Note:  The format of the server serial number is xsvr-999-999-x-xxx-xxx-xxx-xxx-xxx-xxx-
x, where x is a letter and 9 is a digit. The first element (xsvr) and the fourth (x) must be 
lowercase. 

Apple Remote Desktop
You need to obtain at least one copy of Apple Remote Desktop version 2.2 or later if 
you don’t already have one. You’ll use Apple Remote Desktop to configure, monitor, 
and control cluster nodes.

Private Network

Management computer
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Server Tools
You need to install Server Tools on your management computer. The Server Tools suite 
includes:
Â Server Assistant
Â Server Admin
Â Server Monitor
Â Xgrid Admin

You’ll use these tools to remotely manage the cluster. Install these tools using the 
Server Tools CD, which is included with every Xserve computer.
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3 Preparing the Cluster for 
Configuration

Mount the systems on the rack, connect the systems to a 
power source and to the private network, and configure the 
management computer.

To prepare the cluster servers for configuration, you’ll mount them in the racks and 
connect them to the power source and private network. You’ll also set up the 
management computer by installing Apple Remote Desktop and Server Tools.

Preparing the Cluster Nodes For Software Configuration
After you have prepared the physical infrastructure for hosting the cluster, the next 
step is to mount the cluster nodes and prepare them for software configuration.

To prepare the cluster for configuration:
1 Unpack the computers and mount them in the rack.

Use the instructions in the Xserve G5 User’s Guide for more information.

Note:  If you’re using existing Xserve G5 computers, you must perform a clean 
installation of Mac OS X Server v10.4 to restore the systems to factory condition.

2 Record each computer’s serial number and keep the information in a safe place.

When recording the serial numbers, make sure you do it in a way that makes it easy for 
you to tell which serial number belongs to which computer. For example, use a table to 
map a system’s serial number to the name on a label on the system’s front panel.

Serial Number Name

serial_number_0 Head node

serial_number_1 Compute node 1

serial_number_2 Compute node 2

… …
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You can find the serial number of an Xserve G5 computer either of two places:

Â The unit’s back panel

Â The unit’s interior
If you look for the serial number on the unit’s interior, don’t confuse the serial 
number for the server with the serial number for the optical drive—these are 
different numbers. The Xserve G5’s serial number is denoted by “Serial#” (not “S/N”) 
followed by 11 characters. 

3 Connect the cluster computers to a power source.

Consider the following when connecting your servers to the power source:
Â Power cables. Use the long power cables with a horizontal power distribution unit 

(PDU) and the short cables with a vertical PDU. If using the long cables, connect the 
servers in order so that you can tell which cable belongs to which server. You might 
also consider labeling cables to make it easier to map a cable to a server.

Â Connection to the uninterruptible power supply (UPS). You should connect the 
head node, storage devices used by the cluster, and the private network switch to a 
UPS unit to protect against data loss in case of a power outage.

Â UPS connection to wall outlet. Make sure the electrical outlets support the UPS plug 
shape. 

Â Power cord retainer clips. Use the power cord retainer clips that come with your 
Xserve systems, to prevent power cables from slipping out.

Serial number label

Serial number label
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Â Xserve cable-management arms. Use the Xserve cable-management arms, which let 
you open the servers without disconnecting cables. These arms also support the 
cables and relieve strain on the server’s back-panel connectors.

Â Air flow. Don’t let a mass of power cables obstruct air flow.

4 Connect Ethernet port 1 on the head node to the private network.

Note:  Later you’ll connect the secondary Ethernet port of the head node to the public 
network.

5 Connect Ethernet port 1 on the remaining nodes in the cluster to the private network, 
in order.

Connecting the Ethernet cables to the switch in order helps you identify which 
cluster node a cable belongs to. Use the first port on the switch for the head node, the 
second port for the first compute node, the third port for the second compute node, 
and so on.

Setting Up the Management Computer
You’ll use the management computer to remotely set up, configure, and administer 
your cluster.

To set up the management computer:
1 Connect the management computer to the private network.

2 Start the management computer.

Ethernet port 1 (private network)

Private Network

Management computer
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3 Disable AirPort and any network connections other than the one you’ll be using to 
connect to your cluster switch.

4 If they aren’t installed already, install the latest version of the Mac OS X Server tools and 
applications from the Mac OS X Server Administration Tools CD, which is included with 
the Mac OS X Server installation kit.

Once installed, the Mac OS X Server tools and applications are in /Applications/Server/. 

5 Install Apple Remote Desktop on the management computer.

Cluster Setup Overview
Here is a summary of what you’ll be doing in the next three chapters, which involves 
setting up your cluster and running tests to verify that it works. 

Step 1:  Set up the head node.
Once your cluster is assembled and ready, start by setting up and configuring the 
cluster’s head node. This process involves the following:
Â Using Server Assistant on the management computer to remotely set up the server 

software on the head node. Server Assistant will configure the DHCP, VPN, and 
Firewall services on the head node.

Â Using Server Admin, configure the DHCP, Firewall, DNS, Open Directory, and Xgrid 
services.

Instructions for setting up the head node are in Chapter 4, “Setting Up the Head Node.”

Step 2:  Set up the compute nodes.
Setting up the cluster’s compute nodes involves the following:
Â Use Server Assistant on the head node to insert an LDAP automatic server setup 

record into the Open Directory database.
Â Configure compute nodes by simply starting them up. They’ll automatically self-

configure using the information in the Open Directory database, and then they’ll 
restart.

Â Configuring the Xgrid agent software on the compute nodes.

Instructions for setting up the compute nodes are in Chapter 5, “Setting Up Compute 
Nodes.”

Step 3:  Test your cluster setup.
After setting up the cluster’s head and client nodes, you’ll test your cluster by using 
Xgrid Admin and by running sample Xgrid tasks. 

Instructions for testing your cluster are in Chapter 6, “Testing Your Cluster.”
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4 Setting Up the Head Node

In this chapter, you’ll set up the server software on the head 
node and configure the services running on it.

You’ll use Server Assistant, Server Admin, and Apple Remote Desktop to set up and 
configure the head node.

Setting Up the Server Software on the Head Node
Use Server Assistant (located in /Applications/Server/) on the management computer 
to set up the head node.

To set up the head node:
1 Start the head node.

The head node should have only one Ethernet cable connecting Ethernet port 1 
(bottom port) to the private network switch. 

Note:  Only the head node and the management computer should be running on the 
private network.

2 Open Server Assistant on the management computer.

3 In the Welcome screen:

a Select “Set up a remote server.” 
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b Click Continue.

The Destination screen appears. In this screen, there should be one entry showing the 
self-assigned address of the head node. If there’s no entry for the head node, click 
Refresh List to refresh the list of servers in this screen. If you still don’t see the head 
node in the list, see “Can’t See the Head Node in Server Assistant” on page 61 for tips 
on how to solve this problem.

4 In the Destination screen:

a Select the head node (the only entry in the list) 
b Double-click the Password field. 
c Enter the head node’s password (the first eight digits of the head node’s serial 

number).
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d Click Continue.

5 In the Language screen:

a Select the language you want to use to administer the server. 
b Click Continue.

6 In the Keyboard screen:

a Select the keyboard layout for the server. 
b Click Continue.

7 In the Serial Number screen:

a Enter the site-licensed serial number and the site license information. 
b Click Continue.

Note:  Enter the registered owner name and organization information exactly as 
specified by Apple.

8 In the Administrator Account screen:

a Create the user account you’ll use to administer the head node. 
b Click Continue.

9 In the Network Names screen:

a For simplicity, use the same name given to you by your system administrator for both 
the computer name and local hostname. 
For example, if you were assigned macima.mycluster.com as the fully qualified name 
of the head node, use macima for both the computer name and local hostname. 
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b Click Continue.

10 In the Network Interfaces screen:

a Select TCP/IP for the Built-in Ethernet 1 and Built-in Ethernet 2 ports.
b Click Continue.

The Built-in Ethernet 1 port connects the head node to the private network and the 
Built-in Ethernet 2 port connects the head node to the public network.

Note:  If you see multiple entries for the same Ethernet port, simply disable all but one 
of the entries for that port. You may delete the unused entries in Network preferences 
for your system later.

11 In the TCP/IP Connection screen for the Built-in Ethernet 1 port:

a Choose Using DHCP from the Configure IPv4 pop-up menu. 
b Leave the other fields blank.
c Click Continue.

12 In the TCP/IP Connection screen for the Built-in Ethernet 2 port:

a Choose Using DHCP from the Configure IPv4 pop-up menu. 
b Leave the other fields blank.
c Click Continue.

13 In the Directory Usage screen:

a Choose Standalone Server from the “Set directory usage to” pop-up menu. 
b Click Continue.

14 In the Services screen:

a Select the following services:
Â Apple File Service
Â Apple Remote Desktop
Â Network time service
Â Software Update service
Â Xgrid Controller service

Private Network

Gigabit switch

Public Network
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b Click Continue.

15 In the Time Zone screen:

a Select your time zone. 
b Click Continue.

16 In the Network Time screen:

a Select “Use a network time server” and choose a server from the NTP Server pop-up 
menu. 

b Click Continue.

17 In the Confirm Settings screen:

a Review the settings.
b Click Apply.
c Wait for a few minutes for your settings to be applied.

18 When prompted to restart the server, click Continue Now.

After a few minutes, the head node restarts.

19 Quit Server Assistant.
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Configuring the TCP/IP Settings for Ethernet Port 2
Using Apple Remote Desktop on the management computer, configure the TCP/IP 
settings for Ethernet port 2 on the head node to access the public network.

To configure the TCP/IP settings for Ethernet port 2:
1 Open Remote Desktop on the management computer.

2 Click Scanner and choose Local Network from the pop-up menu.

Click the Refresh button (close to top right) if you don’t see the head node.

3 Select the head node from the list and choose Interact > Control.

4 Fill out the administration information and click Add to add the head node to the 
Master List.

5 The Mac OS X Server login screen for your server is presented. Log in to the head node 
as the administrator.

6 Open System Preferences on the head node and click Network.

7 Choose Built-in Ethernet 2 from the Show menu.

8 Choose Manually from the Configure IPv4 pop-up menu.

9 Fill out the fields in the TCP/IP pane using the information you got from your system 
administrator.

10 Click Apply Now.

11 Choose Network Port Configurations from the Show menu.

12 Drag Built-in Ethernet 2 to the top of the list so that it’s the default port.

13 Click Apply Now.

14 Log out from the head node and quit Apple Remote Desktop.

Private Network

Gigabit switch

Public Network
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Connecting the Head Node and the Management Computer 
to the Public Network
You’re now ready to physically connect the head node and the management computer 
to the private network.

To connect the head node and the management computer to the private network:

1 Connect Ethernet port 2 on the head node to the public network.

2 Disconnect the management computer from the private network and connect it to the 
public network.

Note:  The head node should now be connected to both the private and public 
networks.

Running Software Update on the Head Node
Use Remote Desktop on the management computer to connect to the head node and 
update the software on it.

To update the software on the head node:
1 Open Apple Remote Desktop on the management computer.

2 Select Master List.

3 Because your head node now has a permanent external address, remove the reference 
to its temporary address by selecting the old entry and pressing the Delete key. The 
new entry is the permanent address.

4 Choose File > Add by Address.

5 Type the fully qualified name of the head node (from example, head.mycluster.com).

6 Type the head node’s administrator username and password.

7 Click Add. 

If you are unable to add the new entry, See “I can’t reach the head node via the public 
network using Apple Remote Desktop” on page 62.

8 Select the head node from the Master List and click Control.

9 Log in to the head node.

10 Open System Preferences on the head node.

11 Click Software Update.

Ethernet port 2 (public network)

Ethernet port 1 (private network)
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12 Click Check Now.

13 Select the items to install and click “Install n Items,” where n is the number of items you 
have selected.

14 Enter the administrator name and password and click OK.

15 Click Agree if prompted.

Once Software Update is done updating the software, the head node restarts. 

Configuring the TCP/IP Settings for Ethernet Port 1
Using Apple Remote Desktop on the management computer, configure the TCP/IP 
settings for Ethernet port 1 on the head node to access the public network.

To configure the TCP/IP settings for Ethernet port 1:
1 Open Remote Desktop on the management computer.

2 Click Master List and choose Local Network from the pop-up menu.

Click the Refresh button (close to top right) if you don’t see the head node.

3 Select the head node from the list and choose Interact > Control.

4 Fill out the administration information and click Add to add the head node to the 
Master List.

5 Log in to the head node as the administrator.

6 Open System Preferences on the head node and click Network.

7 Choose Built-in Ethernet 1 from the Show menu.

8 Choose Manually from the Configure IPv4 pop-up menu.

Updating the Head Node Remotely
To update the software on the head node from another computer:
1 Open Terminal.

2 Connect to the head node using ssh.

$ ssh mycluster.thisgroup.org

3 Once authenticated, run the softwareupdate command.

$ sudo softwareupdate -i -a

This command installs all appropriate software updates. 

For more information about the softwareupdate command, read its man page.
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9 Fill out the fields in the TCP/IP pane using the following information:

Â IP address:  192.168.1.1
Â Subnet mask:  255.255.255.0
Â Router:  192.168.1.1
Â DNS server:  192.168.1.1, <your external servers here>
Â Search domains:  cluster.private, <your search domains here, if any>

10 Click Apply Now.

11 Log out from the head node and quit Apple Remote Desktop.

Configuring Firewall Settings on the Head Node
Configure the Firewall service on the head node to allow Apple Remote Desktop, VPN, 
and Xgrid traffic. You need to allow traffic on these ports to allow the management 
computer to connect to the head node using VPN over the public network.

Note:  If you are running Mac OS X 10.4.0 through 10.4.3, there is a known issue where 
the DHCP port must be opened on all subnets, including the public network, in the 
firewall settings. If the DHCP port is closed on any single network, DHCP may not 
function properly on the private network. This issue will be addressed in later versions 
of Mac OS X Server.

To configure the firewall settings on the head node:
1 Open Server Admin on the management computer.

2 Connect to the head node using its fully qualified hostname and your administrator 
username and password.

3 Select Firewall from the Computers & Services list (on the left).

4 Click Settings (bottom right), then click Services.

5 Choose “192.168-net” from the “Edit Services for” pop-up menu.

6 Select “Allow all traffic for “192.168-net’ to give compute nodes and any other 
computers running on the private network full access to the head node.

7 Choose “10-net” from the “Edit Services for” pop-up menu.

8 Select “Allow all traffic for ‘10-net’ to give compute nodes and any other computers 
running on the private network full access to the head node.

9 Choose “any” from the “Edit Services for” pop-up menu.

10 Select “Allow only traffic for ‘any’ on these ports.”
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11 Select the following ports (in addition to what’s already selected):

Â ARD 2.0—Apple Remote Desktop 2.0 (3283,5900)
Â IKE NAT Traversal (4500)
Â VPN ISAKMP/IKE (500)
Â VPN L2TP—Layer-Two Tunneling Protocol (1701)
Â Xgrid (4111)

12 Click Save.

13 Click Start Service.

Configuring NAT Settings on the Head Node
Configure the head node to perform IP forwarding and Network Address Translation 
(NAT) on Ethernet port2.

To perform IP forwarding and NAT:
1 Using Server Admin on the management computer, connect to the head node and 

select NAT in the Computers & Services list. 

2 Click Settings (lower left) and select “IP Forwarding and Network Address Translation 
(NAT)”.

3 Choose Built-in Ethernet 2 from the “External network interface” pop-up menu.

4 Click Save. 

5 Click Start Service.

Configuring the DHCP Service
Using Server Admin, configure the DHCP service on the head node to provide LDAP 
and DNS information to compute node. 

To configure the DHCP service:
1 Using Server Admin on the management computer, connect to the head node and 

select DHCP in the Computers & Services list. 

2 Click Settings, then click Subnets.

3 Click Add (+) to create a subnet.
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4 In the General pane:

a Type the subnet name in the Subnet Name field—for example, “Cluster Private 
Network.”

b Type 192.168.1.2 in the Starting IP Address field.
c Type 192.168.1.128 in the Ending IP Address field.
d Type 255.255.255.0 in the Subnet Mask field.
e Select en0 from the Network Interface pop-up menu.
f Type 192.168.1.1 in the Router field.
g Specify a lease time for the IP address served by the DHCP service.
h Click Save.

5 Click DNS.

6 Enter cluster.private in the Default Domain field.
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7 Enter the private and public addresses of the head node in the Name Servers field.

8 Click LDAP.

9 Enter the fully qualified private name of the head node as the server name.

For example, if the hostname of the head node is mycluster.cluster.private, enter 
MYCLUSTER.CLUSTER.PRIVATE (all caps) in the Server Name field.
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10 In the Search Base field, enter the following as the LDAP search base:

dc=cluster,dc=private 

11 Click the Back button (top left corner of the DHCP pane).

12 Enable the subnet you’ve just created.

13 Click Save.

14 Click Start Service.

Configuring the DNS Service
Use Server Admin on the head node to create a local DNS zone file and add records to 
it mapping cluster nodes to their corresponding IP addresses. The Open Directory 
service on the head node requires this information to allow automatic server setup.

To configure the DNS service:
1 Using Server Admin on the management computer, connect to the head node and 

select DNS in the Computers & Services list. 

2 Click Settings, then click General.

3 Select “Zone transfers” and Recursion.

4 Click Zones.

5 Click the Add button.
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6 Enter cluster.private in the Zone Name field.

7 Enter the head node’s hostname (for example, headnode) in the Server Name field.

8 Choose the head node’s private address (for example, 192.168.1.1) from the Server IP 
Address pop-up menu.

9 Click Machines.

10 Click the Add (+) button.

11 Using the head node’s private address as the base, increment it by one and type it in 
the IP Address field as the address of the first compute node.

For example, if the IP address of the head node is 192.168.2.1, type 192.168.2.2 in the IP 
Address field. 

12 Type node02 in the Name field.

13 Click OK.

14 Repeat steps 10 through 13 to add DNS records for the remaining nodes to the zone 
file.

Note:  The name of the second compute node will be node03, the third node04, and so 
on. If you have a large cluster, you can speed up the process of adding DNS records by 
dragging the small icon above the Save button to the desktop, modifying the resulting 
DNS Config.plist to include the mapping information for the compute nodes, and then 
dragging the DNS Config.plist file back to the list in the Machines pane.
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15 Click Save.

16 Start the DNS service.

Configuring the VPN Service
Configure the VPN service to use the head node as the DNS server and cluster.private 
as the domain name. Also configure the network routing information used by the VPN 
service.

To configure the VPN service:
1 Using Server Admin on the management computer, connect to the head node and 

select VPN in the Computers & Services list. 

2 Click Settings.

3 In the L2TP pane, select “Enable L2TP over IPsec.”

4 In the “Starting IP address” field, type 192.168.1.129.

5 In the “Ending IP address” field, type 192.168.1.254.

6 Choose MS-CHAPv2 from the PPP Authentication pop-up menu.

7 Select Shared Secret and type the shared secret to use when connecting to the head 
node over VPN.

8 Click Client Information.

9 Type the private IP address of the head node (192.168.1.1) in the “DNS servers” field.
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10 Type cluster.private in the “Search domains” field.

11 Click the Add (+) button.

12 Type the private network’s address (in this example, 192.168.1.0).

13 Type the subnet mask (in this example, 255.255.255.0).

14 For the network type, use Private.

15 Click Add.

16 Click Save.

17 Start the VPN service.
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Configuring the Head Node As an Open Directory Master
Use Server Admin to configure Open Directory service on the head node. You’ll need 
this service later to take advantage of Open Directory’s automatic server setup, which 
allows you to use information in an LDAP record to set up the compute nodes.

To configure Open Directory settings:
1 Open Server Admin on the management computer, connect to the head node, and 

select Open Directory in the Computers & Services list. 

2 Click Settings (near the bottom of the window), then click General (near the top). 

3 Choose Open Directory Master from the Role pop-up menu 
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4 Enter the requested information.

Name, Short Name, User ID, Password:  You must create a new user account for the 
primary administrator of the LDAP directory. This account is not a copy of the 
administrator account in the server’s local directory domain. You should make the 
names and User ID of the LDAP directory administrator different from the names and 
User IDs of user accounts in the local directory domain. 

Kerberos Realm:  This field is preset to be the same as the server’s private fully qualified 
name converted to capital letters. If the hostname is mycluster, the Kerberos realm 
should be MYCLUSTER.CLUSTER.PRIVATE.

Search Base:  This field is preset to a search base suffix for the new LDAP directory, 
derived from the domain portion of the head node’s private DNS name. It should be 
dc=cluster,dc=private.

5 Click Create.

6 Click Save.

It might take a few minutes for the LDAP directory database to be created.

Warning:  Both the Kerberos Realm and Search Base fields come up in Server Admin 
with incorrect default information. 

Make sure that you enter the correct information. If you don’t, you won’t be able to 
configure the compute nodes in your cluster. 
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Configuring the Xgrid Service
Using Server Admin on the head node, configure it as an Xgrid controller and then 
start the Xgrid service. 

To configure the Xgrid service:
1 Using Server Admin on the management computer, connect to the head node and 

select Xgrid in the Computers & Services list. 

2 Click Settings.

3 Click Controller.

4 Click “Enable controller service.”

5 Choose Password from the Client Authentication pop-up menu and type the password 
that Xgrid clients must use.

The client authentication password lets you restrict who is allowed to use the cluster’s 
computational resources. 

6 Choose None from the Agent Authentication pop-up menu.

7 Click Save.

8 Click Restart when prompted.
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5 Setting Up Compute Nodes

You can simplify the compute node setup process by storing 
the setup information in an LDAP record on the head node 
and serving that information to compute nodes via DHCP.

Server Assistant has an option for storing server configuration information on an LDAP 
server. By creating an LDAP record containing the server configuration information and 
configuring the DHCP service to serve LDAP information (which you’ve already done), 
you can automate the compute node server configuration.

Creating an LDAP Record For Setting Up Compute Nodes
To automate the process of setting up compute nodes, use Server Assistant to save the 
compute node configuration information in an LDAP directory record. In this way, 
when you start the compute nodes for the first time, they’ll use the information 
provided by the DHCP server to retrieve the configuration information from the LDAP 
record you created on the head node and use that information to autoconfigure.

To create an LDAP record for configuring compute nodes:
1 Use Apple Remote Desktop on the management computer to control the head node.

2 On the head node, open Server Assistant (located in /Applications/Server/).

3 In the Welcome screen:

a Select “Save setup information in a file or directory record.” 
b Click Continue.

4 In the Language screen:

a Select the language you want to use to administer the server. 
b Click Continue.

5 In the Keyboard screen:

a Select the keyboard layout for the server. 
b Click Continue.
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6 In the Serial Number screen:

a Enter the site-licensed serial number and the site license information as described on 
page 22 of this document.

b Click Continue.

7 In the Administrator Account screen:

a Create the account you’ll use to administer the compute nodes. 
b Click Continue.

8 In the Network Names screen:

a Leave the fields blank. 
b Click Continue.

9 In the Network Interfaces screen:

a Click Add.
b Type Built-in Ethernet 1 in the Port Name field.
c Type en0 in the Device Name field. Leave the Ethernet Address field blank.
d Click OK.
e Click Add.
f Type Built-in Ethernet 2 in the Port Name field.
g Type en1 in the Device Name field.
h Click OK.
i Click Continue.

10 In the TCP/IP Connection screen for the Built-in Ethernet 1 port:

a Choose Using DHCP from the Configure IPv4 pop-up menu. 
b Leave the other fields blank.
c Click Continue.

11 In the TCP/IP Connection screen for the Built-in Ethernet 2 port:

a Choose Using DHCP from the Configure IPv4 pop-up menu. 
b Leave the other fields blank.
c Click Continue.
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12 In the Directory Usage screen:

a Choose “Connected to a Directory System” from the “Set directory usage to” pop-up 
menu.

b Choose “As Specified by DHCP Server” from the Connect pop-up menu.
c Click Continue.

13 In the Services screen:

a Select the following services:
Â Apple File Service
Â Apple Remote Desktop
Â Xgrid Agent service
b Click Continue.

14 In the Time Zone screen:

a Select your time zone. 
b Click Continue.

15 In the Network Time screen:

a Select “Use a network time server” and choose a server from the NTP Server pop-up 
menu. 

b Click Continue.

16 In the Confirm Settings screen:

a Read the configuration summary to confirm that you have made the correct settings.
b Click Save As.

17 In the “Save settings” sheet:

a Select Directory Record.
b Select “/LDAPv3/127.0.0.1” from the Directory Node pop-up menu.
c Type “generic” in the Record Name field.
d Deselect “Save in Encrypted format.”
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e Click OK and then authenticate using the directory admin login and password you 
created when you configured Open Directory using Server Admin.

18 Quit Server Assistant.

Verifying LDAP Record Creation
Use the slapcat command on the head node to verify the creation of the LDAP 
directory record that will be used by the compute nodes to autoconfigure.

To verify the LDAP record creation:
1 Using Apple Remote Desktop, open a Terminal window on the head node and enter 

the following command:

$ sudo slapcat | grep generic

2 Enter the administrator password when prompted.

This command displays the generic records in the LDAP database on the head node. In 
this case, there should only be one record—the one you have created in the previous 
section.

dn: cn=generic,cn=autoserversetup,dc=cluster,dc=private

cn: generic
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Setting Up the Compute Nodes
To automatically set up the server software on the compute nodes, just start them.

To set up the compute nodes:
1 Make sure that the compute nodes are connected to the private network through 

Ethernet port 1.

2 Start up the compute nodes in order, with a brief delay (30 seconds or more) between 
starts.

During startup, Xserve G5 systems draw more current than when operating at normal 
conditions. If you start all the compute nodes at once, your circuit might not handle 
the instant current draw, unless it has the ability to handle the rated power 
consumption.

Once you start up a compute node, it’ll autoconfigure using the server configuration 
information from the LDAP record you’ve created earlier. After the compute node 
autoconfigures, it restarts.

Creating a VPN Connection on the Management Computer
Create a VPN connection on the management computer to access the cluster’s private 
network. You’ll need this connection to manage compute nodes directly. 

To create a VPN connection:
1 On the management computer, open Internet Connect (located in /Applications/).

2 Create a new VPN connection:

a Choose File > New VPN Connection.
b Select L2TP over IPSec.
c Click Continue.

3 In the VPN (L2TP) pane, enter the address of the head node and its administrator name 
and password.

4 Choose Edit Configurations from the Configuration menu.

5 Enter the shared secret you defined when you configured VPN earlier.

6 Click OK.

7 Click Connect.
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8 Verify that you’re connected to the head node over VPN:

a Open System Preferences and click Network.
b Verify that the Network Status pane has an active VPN (L2TP) connection to the head 

node.
c Double-click the VPN (L2TP) entry.
d Verify that you’re getting a private network address.
e Close System Preferences.

Configuring Xgrid Agent Settings
Connect to the head node over VPN and use Apple Remote Desktop to send 
commands to the compute nodes to configure their Xgrid agent settings.

To configure the Xgrid agent settings:
1 On the management computer, make sure that you’re connected to the head node 

over VPN.

2 Open Apple Remote Desktop.

3 Click Scanner and choose Network Range from the pop-up menu.

4 Enter the starting and ending addresses of the address range used by the compute 
nodes.

5 Select the compute nodes from the list and choose Manage > Send UNIX Command.

6 Enter the following commands in the text field:

serveradmin settings xgrid:AgentSettings:prefs:ControllerName="<head_node>"

serveradmin settings xgrid:AgentSettings:prefs:BindToFirstAvailable=no

serveradmin settings xgrid:AgentSettings:prefs:OnlyWhenIdle=no

serveradmin settings 

xgrid:AgentSettings:prefs:ControllerAuthentication="None"

serveradmin settings xgrid:AgentSettings:Enabled=yes

serveradmin settings xgrid:ControllerSettings:Enabled=no

xgridctl agent start

where <head_node> is the fully qualified private name of the head node (for example, 
macima.cluster.private).

7 Select User and type root in the text field.
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8 Select “Display all output.”

9 Click Send.

These commands configure the Xgrid agent on the compute nodes to bind to the head 
node and then start the Xgrid service.

The compute nodes are now ready to receive Xgrid tasks.
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6 Testing Your Cluster

To ensure that you’ve successfully configured your cluster, 
check it using Xgrid Admin and test it by running sample 
Xgrid tasks.

Use Xgrid Admin to verify that you can see the Xgrid agents in your cluster. Then, use 
sample Xgrid tasks to test your cluster. 

Checking Your Cluster Using Xgrid Admin
Use Xgrid Admin to verify that Xgrid agents are running on the compute nodes.

To use Xgrid Admin to check your cluster:
1 From the management computer, open Xgrid Admin (located in /Applications/Server/).

2 Click Add Controller.

3 Enter the Public IP address or the DNS name of the head node and click Connect.
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4 In the authentication sheet:

a Select “Use password.”
b Type the head node’s administrator password in the text field.
c Click OK.

5 Select the cluster in the Controllers and Grids list.

6 To rename your grid:

a Choose Grid > Rename Grid.
b Enter a new name and click OK.

7 Click Agents.
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8 Verify that you can see a list of all the nodes in your cluster, including the head node. 
Refer to “Solving Problems” if you don’t see all the agents you were expecting. 

Running a Sample Xgrid Task
To test your cluster, use GridSample, a sample Cocoa application that comes with 
Developer Tools for Mac OS X v10.4, to submit Xgrid tasks to the head node. This 
application provides you with an easy-to-use GUI interface to Xgrid. On any system that 
has the Mac OS X developer tools installed, the sample code for the application is at:

/Developer/Examples/Xgrid/GridSample/GridSample.xcode

Using this application, you’ll generate the monthly calendars of the year 2006 across 
the cluster. Although this application is trivial, it lets you test the cluster and it 
illustrates the simplicity of Xgrid job submission.

Note:  You can also submit Xgrid tasks using the xgrid command-line tool. Refer to the 
tool’s man page and to the Mac OS X Server Xgrid Administration guide for more 
information.

To test your cluster using GridSample:
1 On the management computer, use Xcode (located in /Developer/Applications/) to 

open GridSample.xcode.

2 Choose Project > Set Active Executable > Xgrid Feeder Sample to set the active 
executable to Xgrid Feeder Sample.
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3 Click “Build and Go” to build and run the project.

The application starts running and prompts you for an Xgrid controller to connect to.

4 Type the address of the head node and click Connect.

5 Click “Use password,” type the head node’s administrator password, and click OK.

6 Click New Job.

7 Type 2006 Calendars in the Job Name field.

8 Make sure the Command field is set to /usr/bin/cal.

9 Choose Range from the Argument 1 pop-up menu.

10 For argument 1, type 1 in the From field, 12 in the “to” field, and 1 in the “by” field.

This range tells the application to generate the 2006 monthly calendars from January 
through December. 

11 Click the Add (+) button to add another argument below Argument 1. 

12 Choose Literal from the Argument 2 pop-up menu. 

13 For argument 2, type 2006.

Note:  Instead of specifying one year, you could specify a range of years, and Xgrid 
would create a separate set of tasks for each year.
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14 Click Submit. 

The Xgrid controller on the head node prepares the tasks and then hands them out to 
the Xgrid agents running on the cluster nodes. When the job is done, the status of the 
job changes to Finished in the Xgrid Feeder Sample window.

15 Click Show Results to see the results of each task.

Note:  To test image rendering on your cluster, use Xcode to build and run the sample 
application GridMandelbrot.xcode (located in /Developer/Examples/Xgrid/
GridMandelbrot/). Just as you did earlier, build and run the project, connect to the 
Xgrid controller, and submit the job. The application will render Mandelbrot images 
across your cluster.
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7 Solving Problems

Can’t See the Head Node in Server Assistant
If you run Server Assistant on the management computer to remotely set up the head 
node and don’t see it =listed in the Destination screen, try the following to solve the 
problem:
Â Make sure you’re running the latest version of Server Assistant by installing the tools 

from the Server Admin Tools CD that came with your servers, and then running 
Software Update.

Â Make sure the head node has finished booting (the CPU and hard drive indicators on 
the head node’s front panel become idle for an extended period after the head node 
finishes booting).

Â Make sure the head node is connected properly to the private network and not any 
other network. If the server is connected to another network, you must disconnect 
that Ethernet cable and power cycle the server before proceeding. 

Â Make sure the management computer is connected properly to the private network 
and not any other network. If the server is connected to another network, you must 
disconnect that Ethernet cable, or turn off Airport if the connection is wireless, and 
then restart the server before proceeding.

Â In the Destination screen of Server Assistant, click Refresh List.
Â Restart Server Assistant and click Refresh List in the Destination screen of Server 

Assistant.

If you still can’t see the head node, do the following:

1 Obtain the IP address of the head node by typing the following in Terminal:

ping 169.254.255.255

In the results, if you see an IP address other than the management computer’s address, 
then it is the head node’s address (as long as the only computers running on the 
private network are the management computer and the head node).

2 In the Destination screen of Server Assistant, click the address field of the first entry in 
the list and type the head node’s IP address. 

3 Enter the password (the first eight digits of the head node’s serial number).
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4 Click Continue.

If Server Assistant still can’t recognize the head node, reinstall a fresh copy of Mac OS X 
Server v10.4 on the head node using the instructions provided in the Mac OS X Server 
Getting Started guide. 

I can’t reach the head node via the public network using 
Apple Remote Desktop
After you have connected the Ethernet cable to Built-in Ethernet 2 on your head node, 
you should be able to reach the head node from the administrator computer via the 
public network. If you are unable to do so:
Â Verify that the administrator computer can reach other systems on the public 

network.
Â Verify that the fully qualified hostname used by your head node is being resolved by 

your administrator computer. You can verify this by typing host at the command line, 
followed by the hostname of your cluster. If you get an error, you must work with 
your network administrator to resolve this before proceeding.

You may need to verify the configuration of the head node. You must reconnect to 
your head node using the private network:

1 Disconnect the cable from Built-in Ethernet 2 to allow a self-assigned IP address to be 
assigned to Built-in Ethernet 1. If you do not physically disconnect the cable from the 
network, your head node will not be reachable via Built-in Ethernet 1.

2 Disconnect your management computer from the public network and connect it to the 
private network switch.

3 In Apple Remote Desktop, use the network scanner to find the 169.254 address of your 
head node.

4 Click Control to control the head node.

5 Verify the settings as detailed in the section “Configuring the TCP/IP Settings for 
Ethernet Port 2” on page 32.

6 Make sure Built-in Ethernet 2 is first in the list shown in “Network Port Configurations” 
of the Network preferences pane of your head node.

7 Reboot the head node.

Retry your connection via the public network.



Chapter 7    Solving Problems 63

 

System icon in Apple Remote Desktop is black (not blue), and 
I can’t verify the administrator password
In some cases, the system shows up before Apple Remote Desktop has finished 
initializing. You can update the system status by pressing Command-Y in Apple Remote 
Desktop. 

When the system has completed the boot process, the computer should show a blue 
icon in your Scanner and allow its addition to the master list.

Cluster nodes don’t automatically apply their settings 
and reboot
Automatic Server Setup requires all DNS, DHCP, Open Directory, and Firewall settings to 
be correct. If any setting is incorrect, the servers won’t be able to acquire the 
information required for automatic configuration. 

If your systems turn on and never reboot themselves, you must verify that the 
settings provided in this document have been accurately assigned to the head node. 
Pay particular attention to the Open Directory search bases and domains, as specified 
in Open Directory and DNS settings sections.

If you have verified that all settings are correct, consider these other possible causes.
Â External DNS failure:  If your head node is unable to resolve the fully qualified 

hostname from its external DNS server, Open Directory may fail to operate correctly. 
An externally resolvable hostname is mandatory for proper operation.

Â State of the cluster nodes:  If you are not using factory-condition Xserve cluster 
nodes, Mac OS X Server may be already set up on your cluster node(s). Automatic 
server setup only configures Xserve computers that boot to the Server Assistant 
screen. 
To reinstall Mac OS X Server on your cluster nodes, remove the drive modules and 
use the standard Mac OS X Server install process on your head node. On completion, 
reinsert the drive modules into the cluster nodes.

Cluster trips the breaker of the power distribution unit or 
wall outlet
Review the power draw of your servers and other devices, and make sure you aren’t 
exceeding the maximum rated current draw for your power distribution units (PDUs) or 
circuit (wall outlet). If you don’t have access to PDUs with higher ratings, or to wall 
outlets with higher ratings, spread the current of your system across multiple PDUs or 
outlets to remain within the operating range of any single power source.
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Something went wrong and I need to start over
Reinstalling Mac OS X Server on each hard drive enables you to restart the process. 
Following the instructions for a remote operating system install using Server Assistant 
(located at www.apple.com/server/documentation/), install the operating system onto 
the head node, and follow the instructions in this document for configuration of the 
head node.

1 After configuring the head node, shut down the server and remove the drive module. 
Set it aside. 

2 Insert a drive module from one of your cluster nodes, and install Mac OS X Server 
again. 

3 When the installation is complete, remove the drive module and reinsert the 
configured head node drive module into your head node. 

4 In the second drive bay, insert the drive module containing the unconfigured Mac OS X 
Server software you just installed. 

5 Insert a target drive module from another cluster node into drive bay 3.

6 Using the Disk Utility “Restore” feature, erase and block copy the contents of the drive 
in bay 2 to the drive in bay 3. 

7 Repeat for each drive module in your cluster until all have been reimaged with the 
unconfigured Mac OS X Server software.

8 Return to the instructions starting in Chapter 3 to complete the process of setting up 
your cluster.
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Cluster Setup Checklist

Use the checklist in this appendix to guide you through the 
cluster setup procedure

Print this checklist and use it to make sure that you have performed all the setup steps. 
The steps in this checklist are in order only within each section.

For information about this step … Go to …

Physical Setup

N Power source meets minimum 
requirements

“Power Requirements” on page 16

N Cooling system meets minimum 
requirements

“Cooling Requirements” on page 17

N Facility housing the cluster meets 
minimum weight requirements

“Weight Requirements” on page 18

N Space around the cluster meets 
minimum requirements

“Space Requirements” on page 18

N Network switches support Gigabit 
Ethernet and have enough ports

“Network Requirements” on page 19

N Mount cluster nodes on the rack “Network Requirements” on page 19

N Connect cluster nodes to a power source “Preparing the Cluster Nodes For Software 
Configuration” on page 23

N Connect cluster nodes to the private 
network

“Preparing the Cluster Nodes For Software 
Configuration” on page 23

Software Setup

N Obtain a static IP address and related 
network and DNS information

“Network Requirements” on page 19

N Obtain a site-licensed serial number “Site-Licensed Serial Number” on page 20

N Obtain a copy of Apple Remote Desktop “Apple Remote Desktop” on page 20

N Record the serial numbers of the cluster 
nodes

“Preparing the Cluster Nodes For Software 
Configuration” on page 23



66 Appendix     Cluster Setup Checklist

 

Management Computer Setup

N Disable AirPort and any other public 
network connections

“Setting Up the Management Computer” on page 25

N Install the latest version of Mac OS X 
Server tools

“Setting Up the Management Computer” on page 25

N Install Apple Remote Desktop “Setting Up the Management Computer” on page 25

N Create a VPN connection to the head 
node

“Creating a VPN Connection on the Management 
Computer” on page 51

Head Node Setup

N Run Server Assistant “Setting Up the Server Software on the Head Node” 
on page 27

N Configure public network settings “Configuring the TCP/IP Settings for Ethernet Port 2” 
on page 32

N Connect the head node to the public 
network

“Connecting the Head Node and the Management 
Computer to the Public Network” on page 33

N Run Software Update “Running Software Update on the Head Node” on 
page 33

N Configure private network settings “Configuring the TCP/IP Settings for Ethernet Port 1” 
on page 34

N Configure Firewall service “Configuring Firewall Settings on the Head Node” on 
page 35

N Configure NAT service “Configuring NAT Settings on the Head Node” on 
page 36

N Configure DHCP service “Configuring the DHCP Service” on page 36

N Configure DNS service “Configuring the DNS Service” on page 39

N Configure VPN service “Configuring the VPN Service” on page 41

N Configure Open Directory service “Configuring the Head Node As an Open Directory 
Master” on page 43

N Configure Xgrid service “Configuring the Xgrid Service” on page 45

Compute Node Setup

N Create an LDAP record for setting up the 
compute nodes

“Creating an LDAP Record For Setting Up Compute 
Nodes” on page 47

N Set up compute nodes using LDAP 
record

“Setting Up the Compute Nodes” on page 51

N Configure Xgrid agent settings “Configuring Xgrid Agent Settings” on page 52

Cluster Testing

N Check the cluster using Xgrid Admin “Checking Your Cluster Using Xgrid Admin” on 
page 55

N Run sample Xgrid tasks on the cluster “Running a Sample Xgrid Task” on page 57

For information about this step … Go to …
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address  A number or other identifier that uniquely identifies a computer on a network, 
a block of data stored on a disk, or a location in computer memory. See also IP address, 
MAC address.

administrator  A user with server or directory domain administration privileges. 
Administrators are always members of the predefined “admin” group.

AFP  Apple Filing Protocol. A client/server protocol used by Apple file service on 
Macintosh-compatible computers to share files and network services. AFP uses TCP/IP 
and other protocols to communicate between computers on a network.

aggregation  Combining similar objects or resources (such as disks or network 
connections) into a single logical resource in order to achieve increased performance. 
For example, two or more disks can be aggregated into a single logical disk to provide 
a single volume with increased capacity.

Apple Filing Protocol  See AFP.

AppleScript  A scripting language with English-like syntax, used to write script files that 
can control your computer. AppleScript is part of Mac OS X and is included on every 
Macintosh.

automatic backup  A backup triggered by an event (such as a scheduled time, or the 
exceeding of a storage limit) rather than by a human action.

automatic failover  Failover that occurs without human intervention. In Xsan, failover is 
the automatic process by which a standby metadata controller becomes the active 
metadata controller if the primary controller fails.

availability  The amount of time that a system is available during those time periods 
when it’s expected to be available. See also high availability.

back up (verb)  The act of creating a backup.

backup (noun)  A collection of data that’s stored for purposes of recovery in case the 
original copy of data is lost or becomes inaccessible.
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bit  A single piece of information, with a value of either 0 or 1.

bit rate  The speed at which bits are transmitted over a network, usually expressed in 
bits per second.

byte  A basic unit of measure for data, equal to eight bits.

client  A computer that requests data or services from a server computer.

cluster  A collection of computers, interconnected in order to improve reliability, 
availability, and performance. Clustered computers often run special software to 
coordinate the computers’ activities. See also computational cluster.

cluster node  High performance computing (HPC) clusters provide increased 
performance by splitting a computational task across many different nodes in a 
computing cluster, typically connected by a private network. The Xserve cluster node 
computer is accessed via remote command line. See also computational cluster.

command-line interface  A way to interface with the computer (for example, to run 
programs or modify file system permissions) by typing text commands at a shell 
prompt.

Common Internet File System  See SMB/CIFS.

computational cluster  A collection of computers or servers that are grouped together 
to share the processing of a task at a high level of performance. A computational 
cluster can perform larger tasks than a single computer would be able to complete, 
and such a grouping of computers (or “nodes”) can achieve high performance 
comparable to a supercomputer.

compute node  Typically, a compute node runs only a small, monolithic kernel of the 
operating system, which frees up memory for processing tasks. Compute nodes usually 
have only a single drive bay and minimal hardware resources. 

data rate  The amount of information transmitted per second.

default  The action performed by a program automatically, unless the user chooses 
otherwise.

deploy  To place configured computer systems into a specific environment or make 
them available for use in that environment.

disk  A rewritable data storage device. See also disk drive, logical disk.

disk drive  A device that contains a disk and reads and writes data to the disk. See also 
disk, logical disk.
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disk image  A file that, when opened, creates an icon on the Mac OS desktop that looks 
and acts like an actual disk or volume. Using NetBoot, client computers can start up 
over the network from a server-based disk image that contains system software. Disk 
image files have a filename extension of either .img or .dmg. The two image formats 
are similar and are represented with the same icon in the Finder. The .dmg format 
cannot be used on computers running Mac OS 9.

DNS  Domain Name System. A distributed database that maps IP addresses to domain 
names. A DNS server, also known as a name server, keeps a list of names and the IP 
addresses associated with each name.

DNS domain  A unique name (and associated address) for a host computer operating 
on the public Internet, such as www.apple.com. Also called a domain name.

DNS name  A unique name of a computer used in the Domain Name System to 
translate IP addresses and names. Also called a domain name.

domain  Part of the domain name of a computer on the Internet. It does not include 
the top level domain designator (for example, .com, .net, .us, .uk). Domain name 
“www.example.com” consists of the subdomain or host name “www,” the domain 
“example,” and the top level domain “com.”

domain name  See DNS domain.

Domain Name System  See DNS.

Ethernet  A common local area networking technology in which data is transmitted in 
units called packets using protocols such as TCP/IP.

Ethernet adapter  An adapter that connects a device to an Ethernet network. Usually 
called an Ethernet card or Ethernet NIC. See also NIC.

Fibre Channel  The architecture on which most SAN implementations are built. Fibre 
Channel is a technology standard that allows data to be transferred from one network 
node to another at very high speeds.

file system  A scheme for storing data on storage devices that allows applications to 
read and write files without having to deal with lower-level details.

GB  Gigabyte—a common measurement of storage capacity. 1,073,741,824 (230) bytes.

Gigabit Ethernet  A group of Ethernet standards in which data is transmitted at 1 
gigabit per second (Gbit/s). Abbreviated GBE.

gigabyte  See GB.

head node  A computing cluster has one “head node” that manages the work being 
done by the cluster, while the computing clusters do the actual work.
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high availability  The ability of a system to perform its function continuously (without 
interruption).

host name  A unique name for a server, historically referred to as the UNIX hostname. 
In Mac OS X Server, the host name is used primarily for client access to NFS home 
directories. A server determines its host name by using the first name available from 
the following sources:  the name specified in the /etc/hostconfig file 
(HOSTNAME=some-host-name); the name provided by the DHCP or BootP server for 
the primary IP address; the first name returned by a reverse DNS (address-to-name) 
query for the primary IP address; the local hostname; the name “localhost.”

HTTP  Hypertext Transfer Protocol. The client/server protocol for the World Wide Web. 
The HTTP protocol provides a way for a web browser to access a web server and 
request hypermedia documents created using HTML.

Hypertext Transfer Protocol  See HTTP.

image  See disk image.

Internet  Generally speaking, a set of interconnected computer networks 
communicating through a common protocol (TCP/IP). The Internet (note the 
capitalization) is the most extensive publicly accessible system of interconnected 
computer networks in the world.

Internet Protocol  See IP.

IP  Internet Protocol. Also known as IPv4. A method used with Transmission Control 
Protocol (TCP) to send data between computers over a local network or the Internet. IP 
delivers packets of data, while TCP keeps track of data packets.

IP address  A unique numeric address that identifies a computer on the Internet.

KB  Kilobyte—a common measurement of storage capacity. 1,024 (210) bytes.

kilobyte  See KB.

link  An active physical connection (electrical or optical) between two nodes on a 
network.

link aggregation  Configuring several physical network links as a single logical link to 
improve the capacity and availability of network connections. With link aggregation, all 
ports are assigned the same ID. Compare to multipathing, in which each port keeps its 
own address.

load balancing  The process of distributing client computers’ requests for network 
services across multiple servers to optimize performance.
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log in (verb)  The act of starting a session with a system (often by authenticating as a 
user with an account on the system) in order to obtain services or access files. Note 
that logging in is separate from connecting, which merely entails establishing a 
physical link with the system.

logical disk  A data storage device that appears to the user as a single disk for storing 
files, even though it may actually consist of more than one physical disk drive. See also 
disk, disk drive.

Mac OS X  The latest version of the Apple operating system. Mac OS X combines the 
reliability of UNIX with the ease of use of Macintosh.

Mac OS X Server  An industrial-strength server platform that supports Mac, Windows, 
UNIX, and Linux clients out of the box and provides a suite of scalable workgroup and 
network services plus advanced remote management tools.

management computer  The management computer in an HPC configuration breaks 
large computational problems into pieces (data partitions), exchanges or replicates the 
information across the pieces when necessary, and puts the resulting data sets back 
together into the final answer—See the definition under head node.

MB  Megabyte—a common measurement of storage capacity. 1,048,576 (220) bytes.

MB/s  Abbreviation for megabytes per second, usually referring to data transfer rate.

Mbit  Abbreviation for megabit.

Mbit/s  Abbreviation for megabits per second.

megabyte  See MB.

name server  A server on a network that keeps a list of names and the IP addresses 
associated with each name. See also DNS, WINS.

Network File System  See NFS.

network interface  Your computer’s hardware connection to a network. This includes 
(but isn’t limited to) Ethernet connections, AirPort cards, and FireWire connections.

network interface card  See NIC.

NFS  Network File System. A client/server protocol that uses Internet Protocol (IP) to 
allow remote users to access files as though they were local. NFS exports shared 
volumes to computers according to IP address, rather than user name and password.

NIC  Network interface card—an adapter that connects a computer or other device to a 
network. NIC is usually used to refer to adapters in Ethernet networking; in Fibre 
Channel networking, the interface is usually called a host bus adapter (HBA).
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Open Directory  The Apple directory services architecture, which can access 
authoritative information about users and network resources from directory domains 
that use LDAP, NetInfo, or Active Directory protocols; BSD configuration files; and 
network services.

open source  A term for the cooperative development of software by the Internet 
community. The basic principle is to involve as many people as possible in writing and 
debugging code by publishing the source code and encouraging the formation of a 
large community of developers who will submit modifications and enhancements.

port  A sort of virtual mail slot. A server uses port numbers to determine which 
application should receive data packets. Firewalls use port numbers to determine 
whether data packets are allowed to traverse a local network. “Port” usually refers to 
either a TCP or UDP port.

port name  A unique identifier assigned to a Fibre Channel port.

private network  A private network is a network that uses RFC 1918 IP address space 
rather than publicly routed IP space. A private network is used within the HPC domain, 
and each cluster node will have a private network IP address.

protocol  A set of rules that determines how data is sent back and forth between two 
applications.

public network  The public network is available for external connections. Every node 
may also have a public network IP address.

RAID  Redundant Array of Independent (or Inexpensive) Disks. A grouping of multiple 
physical hard disks into a disk array, which either provides high-speed access to stored 
data, mirrors the data so that it can be rebuilt in case of disk failure, or both of these 
features. The RAID array is presented to the storage system as a single logical storage 
unit. See also RAID array, RAID level.

RAID 1  A RAID scheme that creates a pair of mirrored drives with identical copies of 
the same data. It provides a high level of data availability.

RAID array  A group of physical disks organized and protected by a RAID scheme and 
presented by RAID hardware or software as a single logical disk. In Xsan, RAID arrays 
appear as LUNs, which are combined to form storage pools.

RAID level  A storage allocation scheme used for storing data on a RAID array. Specified 
by a number, as in RAID 3 or RAID 0+1.
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router  A computer networking device that forwards data packets toward their 
destinations. A router is a special form of gateway which links related network 
segments. In the small office or home, the term router often means an Internet 
gateway, often with Network Address Translation (NAT) functions. Although generally 
correct, the term router more properly refers to a network device with dedicated 
routing hardware.

server  A computer that provides services (such as file service, mail service, or web 
service) to other computers or network devices.

Server Message Block/Common Internet File System  See SMB/CIFS.

SMB/CIFS  Server Message Block/Common Internet File System. A protocol that allows 
client computers to access files and network services. It can be used over TCP/IP, the 
Internet, and other network protocols. Windows services use SMB/CIFS to provide 
access to servers, printers, and other network resources.

switch  Networking hardware that connects multiple nodes (or computers) together. 
Switches are used in both Ethernet and Fibre Channel networking to provide fast 
connections between devices.
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